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1. Johdanto 

Pohjaveden tyyppimuodostumien rakennekuvaukset on laadittu 1990-luvulla perustuen 
pohjavesialueiden kartoitukseen, muodostumien rakenteiden tilastolliseen tarkasteluun sekä 
tiesuolauksen riskikartoitukseen. Tyyppimuodostumista laadittiin tuolloin myös pohjavesimallit, mutta 
ne tehtiin HST3D-ohjelmistolla, joka ei ole yleisessä käytössä, eikä tiedostoja ole saatavilla 
sähköisessä muodossa. 

Jotta jo olemassa olevat tyyppimuodostumamallit saataisiin yleisesti hyödynnettäviksi, ne on Suomen 
ympäristökeskuksessa laadittu uudelleen yleisesti käytössä olevan MODFLOW-ohjelmiston kanssa 
yhteensopivassa muodossa. MODFLOW-ohjelmaperheen varsinaiset laskentaohjelmat voi ladata 
internetistä ilmaiseksi ja sieltä on niille ladattavissa myös ilmainen graafinen käyttöliittymä ModelMuse.  

Tyyppimallien kanssa on käytetty seuraavia ohjelmia: 

– ModelMuse, käyttöliittymä 
– MODFLOW, pohjaveden virtauskuvan laskenta 
– MODPATH, pohjaveden virtausreittien laskenta 
– MT3DMS, aineiden pitoisuuslaskenta pohjavedessä 
– GW Chart, kuvaajia tuloksista 

ModelMuse, MODFLOW, MODPATH ja GW Chart ovat Yhdysvaltain geologian tutkimuskeskuksen 
(United States Geological Survey, USGS) laatimia ohjelmia. MT3DMS on laadittu Alabaman 
yliopistossa Yhdysvalloissa. 

ModelMuse-käyttöliittymän ja MODFLOW-perheen ohjelmien käyttöön liittyen löytyy internetistä 
materiaalia: 

- ModelMuse-manuaali https://pubs.usgs.gov/tm/tm6A29 (Winston, R.B. 2009) 
- ModelMuse-ohjevideot 

https://water.usgs.gov/nrp/gwsoftware/ModelMuse/ModelMuseVideos.html 
- infoa MODFLOW-aloittelijoille: 

https://water.usgs.gov/nrp/gwsoftware/ModelMuse/Help/index.html?beginners_guide_to_modfl
ow.htm 

- Ympäristöopas 121 (Seppälä & Tuominen 2005) 

Syvemmälle malleihin voi perehtyä internetistä löytyvien julkaisujen avulla: 

- USGS:n MODFLOW-julkaisu A modular three-dimensional finite-difference ground-water flow 
model (McDonald M.G. & Harbaugh A.W. 1988) 

- USGS:n MODPATH-julkaisu User's guide for MODPATH/MODPATH-PLOT (Pollock 1994) 
- MT3DMS-julkaisu MT3DMS – A Modular Three-Dimensional Multispecies Transport Model 

(Zheng & Wang 1999) 

  

https://pubs.usgs.gov/tm/tm6A29
https://water.usgs.gov/nrp/gwsoftware/ModelMuse/ModelMuseVideos.html
https://water.usgs.gov/nrp/gwsoftware/ModelMuse/Help/index.html?beginners_guide_to_modflow.htm
https://water.usgs.gov/nrp/gwsoftware/ModelMuse/Help/index.html?beginners_guide_to_modflow.htm
https://helda.helsinki.fi/handle/10138/41774
https://pubs.usgs.gov/twri/twri6a1/html/pdf.html
https://pubs.usgs.gov/twri/twri6a1/html/pdf.html
http://pubs.er.usgs.gov/usgspubs/ofr/ofr94464
https://apps.dtic.mil/dtic/tr/fulltext/u2/a373474.pdf
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2. Ohjelmien asennus 

Asennus on varminta teettää kunkin instanssin omalla ICT-tuella.  

Taulukko 1. TYYLI-mallien kanssa käytetyt ohjelmat ja linkit nettisivuille, joilta ne voi ladata. Linkit tarkistettu 
22.12.2020. 

Ohjelma versio linkki Huomioitavaa 

ModelMuse 4.3.0.0 tai 
uudempi 

https://water.usgs.gov/nrp/gwsoftwar
e/ModelMuse/ModelMuse.html 

Nettisivulta valitaan oman työkoneen 
käyttöjärjestelmän (32-bit / 64-bit) mukaan 
sopiva lataus 

Asentaminen saattaa vaatia oman 
työpaikan ICT-tuen 

MODFLOW MODFLOW-
2005 

https://water.usgs.gov/ogw/modflow/
mf2005.html 

asennukseksi riittää .zip-tiedostopaketin 
lataus ja purku sopivaan kansioon eli 
tämän voi asentaa itsekin 

MODPATH versio 6 https://water.usgs.gov/ogw/modpath/ 

 

Versio 6 ei ole tuorein MODPATH:in versio, 
sen asennuspaketti pitää etsiä otsikon 
”Superseded MODPATH Versions” alta 

asennukseksi riittää .zip-tiedostopaketin 
lataus ja purku sopivaan kansioon eli 
tämän voi asentaa itsekin 

MT3DMS versio 5.3 https://hydro.geo.ua.edu/mt3d/index.
htm 

Asentaminen saattaa vaatia oman 
työpaikan ICT-tuen 

GW Chart  https://water.usgs.gov/nrp/gwsoftwar
e/GW_Chart/GW_Chart.html 

Asentaminen saattaa vaatia oman 
työpaikan ICT-tuen 

 

Laskentaohjelmien MODFLOW, MODPATH ja MT3DMS lataussivujen osoitteet on katsottavissa myös 
ModelMuse-käyttöliittymän kohdasta Model → MODFLOW Program Locations, jossa käyttäjän on 
ilmoitettava käyttöliittymälle, mitä exe-tiedostoa minkäkin laskentaohjelman kohdalla käytetään ja 
missä kansiossa ne sijaitsevat. 

  

https://water.usgs.gov/nrp/gwsoftware/ModelMuse/ModelMuse.html
https://water.usgs.gov/nrp/gwsoftware/ModelMuse/ModelMuse.html
https://water.usgs.gov/ogw/modflow/mf2005.html
https://water.usgs.gov/ogw/modflow/mf2005.html
https://water.usgs.gov/ogw/modpath/
https://hydro.geo.ua.edu/mt3d/index.htm
https://hydro.geo.ua.edu/mt3d/index.htm
https://hydro.geo.ua.edu/mt3d/index.htm
https://hydro.geo.ua.edu/mt3d/index.htm
https://water.usgs.gov/nrp/gwsoftware/GW_Chart/GW_Chart.html
https://water.usgs.gov/nrp/gwsoftware/GW_Chart/GW_Chart.html
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3. Tyyppimallin lataaminen 

3.1. Tyyppimuodostuman valinta 

Suomen ympäristökeskuksen ylläpitämään pohjavesitietojärjestelmään (Hertta → POVET 
http://www.syke.fi/fi-FI/Avoin_tieto/Ymparistotietojarjestelmat) on kunkin pohjavesialueen tietoihin 
kirjattu akviferityyppi. Niitä ei kuitenkaan välttämättä ole jaoteltu tilastolliseen analyysiin perustuvien 
muodostumatyyppien mukaisesti (Hänninen ym. 1994). Pohjavesialueen akviferityypin tarkastelemista 
varten vaaditaan rekisteröityminen/kirjautuminen ympäristötietojärjestelmiin. Kirjautuminen SYKEn 
avoimeen tietoon: https://wwwp2.ymparisto.fi/scripts/kirjaudu.asp. 

 

 

Tyyppimalleja on laadittu seuraaville tyyppimuodostumille: 

 

● 1 Pitkittäisharju 
• matalan veden tyyppi, ympäristöön purkava 

● 2A Pitkittäisharju 
• syvän veden tyyppi, ympäristöön purkava 
• mediaanikoko 
• pieni koko 

● 2B Pitkittäisharju 
• syvän veden tyyppi, ympäristöstään keräävä 

● 3 Pitkittäisharju 
• Pohjanmaan tyyppi 

● 4 Reunamuodostuma 
• Salpausselkätyyppinen 

Kuva 1. Tyyppimuodostumien suuntaa 
antavat esiintymisalueet (Niemi ym. 1994) 

 

 

Hänninen ym. (1994) ovat raportissaan kuvanneet tyyppimuodostumat seuraavasti: 

Matalaan veteen kerrostuneissa harjuissa (tyyppi 1) on suhteellisen kapea, jyrkkärinteinen ja 
peräkkäisten harjukuoppien reunustama ydinselänne sekä laakea deltamainen lieveosa. Kerrokset 
ovat yleensä lähes vaaka-asentoisia. Selänteet ja niiden sivuilla olevat muodostumat ovat usein 
kerrostuneet silloiseen vedenpinnan tasoon. 

Syvään veteen kerrostuneille harjuille (tyypit 2A ja 2B) ominaisia ovat perättäisistä kummuista ja 
sianselän muotoisista epäyhtenäisistä selänteistä koostuvat jaksot. Soravaltainen aines esiintyy 
rinteiden suuntaan viettävinä kerroksina ja linsseinä. Selänteitä ympäröivät lievealueet ovat matalia ja 
laaja-alaisia. Harjutyyppiä esiintyy alueilla, joilla mannerjäätikön reuna on päättynyt syvään veteen. 

Pohjanmaan pitkittäisharjut (tyyppi 3) ovat tyypillisesti tasoittuneita, muodostaan laakeita 
selännejaksoja, jotka eivät juuri kohoa ympäristöstään. Selänteen pinta on tasoittumisen aikana 
rikastunut karkearakeisesta aineksesta ja peittynyt myöhemmin rantakerrostumien alle. 

Salpausselkätyyppisissä reunamuodostumissa (tyyppi 4) aines on karkeinta jäätikön puoleisella, 
proksimaalirinteellä, reunamuodostumaan liittyvien niin sanottujen syöttöharjujen kohdalla. 
Proksimaalirinteellä on yleensä moreenia, jota esiintyy myös laattoina ja välikerroksina lajittuneen 
aineksen seassa. 

http://www.syke.fi/fi-FI/Avoin_tieto/Ymparistotietojarjestelmat
https://wwwp2.ymparisto.fi/scripts/kirjaudu.asp


 

 

5 

 

Jaottelu ei kata kaikkia pohjavesialueita. Tyypittelyn ulkopuolella ovat savipeitteiset pohjavesialueet, 
deltamuodostumat, rantakerrostumat sekä muut luokittelemattomat hiekka- ja soramuodostumat. 
Tyyppimuodostumien ja -mallien poikkileikkaukset on esitetty kuvassa 1. 

 

 

Kuva 2. Tyyppimuodostumien ja niitä vastaavien tyyppimallien poikkileikkaukset. 

 

3.2. Kulkeutumistapauksen valinta 

Tyyppimalleja on luotu kulkeutumistapauksen suhteen kolmenlaisia: 

- tie pitkin muodostumaa 
o pitkulainen päästölähde 
o kulkeutuvana aineena kloridi 
o päästön ajalliset vaiheet:  

1. tiesuolaushistoria 1970-1992 
2. 30 vuotta jollakin suolausstrategialla (esim. 9.6 / 0 t/km/vuosi) 

o simuloinneista on olemassa aiemmat HST3D-versiot 
- tie muodostuman poikki 

o pitkulainen päästölähde 
o kulkeutuvana aineena kloridi 
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o päästön ajalliset vaiheet:  
1. tiesuolaushistoria 1970-1992 
2. 30 vuotta jollakin suolausstrategialla (esim. 9.6 / 0 t/km/vuosi) 

o simuloinneista ei ole olemassa aiempia HST3D-versioita 
- yleinen tapaus 

o neliömäinen päästölähde 
o kulkeutuvana aineena ”aine X” 
o päästön ajalliset vaiheet:  

1. 15 vuoden ajan imeytyvän veden pitoisuus päästölähteen kohdalla 100 (mg/l) 
2. 38 vuoden ajan imeytyvän veden pitoisuus päästölähteen kohdalla 0 (mg/l) 

o simuloinneista ei ole olemassa aiempia HST3D-versioita 

Kaikkia kulkeutumistapauksia on mahdollista muokata päästön geometrian, aineen pitoisuuden ja 
päästön ajallisen keston osalta. 

3.3. Tiedostopaketin lataus ja purku 

Tyyppimallien tiedostopaketit ovat ladattavissa nettisivulta 
https://www.syke.fi/fi-
FI/Tutkimus__kehittaminen/Vesi/Mallit_ja_tyokalut/Pohjaveden_tyyppimallit/Pohjaveden_tyyppimallien
_tiedostopaketit(47851) 
Ladataan nettisivulta sopiva zip-tiedosto ja puretaan se omaan kansioon omalle tietokoneelle. 

  

https://www.syke.fi/fi-FI/Tutkimus__kehittaminen/Vesi/Mallit_ja_tyokalut/Pohjaveden_tyyppimallit/Pohjaveden_tyyppimallien_tiedostopaketit(47851)
https://www.syke.fi/fi-FI/Tutkimus__kehittaminen/Vesi/Mallit_ja_tyokalut/Pohjaveden_tyyppimallit/Pohjaveden_tyyppimallien_tiedostopaketit(47851)
https://www.syke.fi/fi-FI/Tutkimus__kehittaminen/Vesi/Mallit_ja_tyokalut/Pohjaveden_tyyppimallit/Pohjaveden_tyyppimallien_tiedostopaketit(47851)
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4. Tyyppimallin avaaminen 

ModelMuse-käyttöliittymä käynnistetään kuvassa 3 näkyvästä ikonista. 

 

 

Kuva 3. ModelMuse-ikoni 

 

Tämän jälkeen avautuvassa ModelMuse- aloitusikkunassa valitaan toiminto: luodaan uusi 
MODFLOW-, PHAST- tai SUTRA-malli tai WellFootprint-projekti, avataan olemassa oleva ModelMuse 
projekti tai tuodaan jossain toisessa ohjelmassa luotu MODFLOW-2005 tai MODFLOW-NWT-malli. 
Kun tyyppimallia ollaan avaamassa ensimmäistä kertaa, valitaan ”Open an existing ModelMuse 
project” kuten kuvassa 4.  

 

 

Kuva 4. ModelMuse-aloitusikkuna 

 

Kohdasta ”Next” päästään navigoimaan siihen kansioon, johon netistä ladattu zip-paketti on purettu. 
Kyseisestä kansiosta valitaan gpt-loppuinen tiedosto, avataan se, jolloin avautuu ModelMuse-
käyttöliittymän perusnäkymä. 
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5. ModelMuse-työkalut 

 

Kuva 5. ModelMuse-käyttöliittymän perusnäkymä (R.B. Winston 2009). 

 

ModelMuse-käyttöliittymän perusnäkymän osat (kuvat 5 ja 6) ovat 

- päävalikko 
o listaus liitteessä 1 

- painikkeet 
o listaus liitteessä 2 
o painikekokonaisuuksia voi siirrellä, mutta ei muuttaa 

- näkymät eri suunnista 
o Näkymä päältä -laskentakerros näkyy muissa näkymissä punaisena 
o Näkymä edestä -laskentarivi näkyy muissa näkymissä vihreänä 
o Näkymä sivulta -laskentasarake näkyy muissa näkymissä sinisenä 

- valintakuutiot 
o näytetään/valitaan mitä kerrosta/riviä/saraketta näkymässä tarkastellaan. 

- viivaimet 
- tilarivi 

 

 

 
Kuva 6. ModelMuse-käyttöliittymän Näkymä päältä -osion osat (R.B. Winston 2009). 
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6. Tyyppimallin asetukset 

Taulukko 2. Tyyppimalleja laadittaessa on tehdyt seuraavat valinnat/asetukset. 

 Valinta/asetus Valitaan/asetetaan kohdassa 

MODFLOW-laskentamalli MODFLOW-2005 Model Selection 

Flow Package Layer Property Flow (LPF) Model → MODFLOW Packages and 
Programs → Flow Packages 

Solver Preconditioned Conjugate 
Gradient (PCG) 

Model → MODFLOW Packages and 
Programs → Solvers 

Laskentakerrosten määrä 4–6 Model → MODFLOW Layer Groups 
→ Discretization 

Laskentakerrosten tyypit Ylimmäinen osa: Convertible 
Alemmat osat: Confined 

Model → MODFLOW Layer Groups 
→ Basics 

   

  Model → MODFLOW Layer Groups 
→ Basics 

Dispersio horisontaalinen ja vertikaalinen 
dispersio on 0.2 * 
pituussuuntainen dispersio, 
diffuusio 0 

Model → MODFLOW Layer Groups 
→ Dispersion 

Yksiköt pituus m, aika s, massa mg Model → MODFLOW Options → 
Options 

Wetting eli iteroinnin aikana 
tahattomasti ”kuivuneiden” 
laskentasolujen kastelu 

aktiivinen, tarkistetaan 
jokaisella iterointikierroksella 

Model → MODFLOW Options → 
Wetting 

Ky 

Kz 

Ky = Kx 

Kz = Kx /10 

Data → Data Sets → Hydrology → Ky 

Data → Data Sets → Hydrology → Kz 

Huokoisuus 0.25 Data → Data Sets → MODPATH \ 
MT3DMS or MT3D-USGS → Porosity 

Painekorkeuden 
laskentatuloksen 
tallennustyyppi 

binäärinen  
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7. Tyyppimallin muokkaaminen 

7.1. Kulkeutumismallin muokkaaminen ilman virtausmallin muuttamista 

Kulkeutumismalliin voi tehdä seuraavat muutokset ilman, että virtausmalliin tarvitsee tehdä muutoksia: 

- päästölähteen paikka 
o päästölähteen siirtäminen sellaisenaan 
o päästölähteen muotoilu 
o päästölähteen jakaminen useampaan osaan 

- päästön ajankohta 
- kulkeutuvan aineen tiedot 

o muuttujatyypit 
▪ Konservatiivinen 
▪ Sorptio mukana 
▪ Hajoaminen mukana 

o päästön reunaehtotyyppi 
▪ pysyvä pitoisuus laskentasolussa 
▪ imeytyvän veden pitoisuus 

o päästön pitoisuudet 

Lisäksi, mallin resoluution lisääminen laskentaruudukkoa tiuhentamalla ei vaadi varsinaisia muutoksia 
virtausmallissa, mutta virtauksen laskenta (MODFLOW) on suoritettava resoluutiomuutosten jälkeen 
uudelleen ennen pitoisuuslaskentaa (MT3DMS). 

7.2. Virtausmallin muokkaaminen 

Virtausmalliin voi tehdä seuraavia muutoksia ilman, että virtauskuva varsinaisesti muuttuu 
alkuperäisestä: 

- mallin korkeusaseman muutos 
- vedenoton siirtäminen tai jakaminen 
- resoluution lisääminen 
- laskentakerrosten jakaminen 
- rivien & sarakkeiden jakaminen 

o koko alueelle tai osaan aluetta 
o laskentatiheyden muutosten pehmentäminen 
o laskentaruudut K-arvovyöhykkeiden rajojen kanssa yhteneviksi 

Seuraavista virtausmalliin tehtävissä olevista muutoksista seuraa virtauskuvan muuttuminen 
alkuperäisestä: 

- Kerrospaksuuksien muutos 
- K-arvojen muutos 
- Reunaehtojen muutos 

o Vedenoton kokonaismäärän muutos 
o Imeynnän muutos 
o Veden purkautumisen muutos 
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8. Mallien ajaminen 

Laskenta-ajot voidaan käynnistää kohdasta File → Export, josta sitten valitaan joko MODFLOW-2005 
Input Files, MODPATH Input Files tai MT3DMS Input Files sen mukaan, mitä laskentaa ollaan 
tekemässä. Vaihtoehtoisesti laskennat voi käynnistää painikkeesta, joka on esitetty kuvassa 7. 

 

 

Kuva 7. ModelMuse-käyttöliittymän painike, jolla käynnistetään laskennat (R.B. Winston 2009). 

9. Tulosten tarkastelu 

9.1.  Tulosten tarkastelu ModelMusella 

Laskenta-ajojen tulokset, joita voidaan tarkastella sama-arvokäyrinä tai -värityksinä ModelMusella: 

- pohjavedenpinnan tai vedenpaineen korkeudet  
- aineen pitoisuudet  

Tulostiedostot avataan  -painikkeella tai kohdasta File → Import → Model Results. 
Tulostiedostotyypeistä keskeisiä ovat 

- bhd: pohjaveden painekorkeudet 
- ucn: aineen pitoisuudet 
- path: virtausreitit 

9.2.  Tulosten tarkastelu GW Chart:lla 

Havaintopiste/laskentasolukohtaisten pitoisuuksien ja pohjaveden pinnan/painekorkeuksien käyrät 
luodaan/katsotaan ohjelmalla GW Chart (ohjelma on ladattavissa sivulta 
https://water.usgs.gov/nrp/gwsoftware/GW_Chart/GW_Chart.html) 
• Chart Type/Convert → Hydrographs 

o MT3DMS Observations -> Read -> avataan jokin .mto-tiedosto 
o MT3DMS Concentrations  

• Number of Cells: monenko laskentasolun pitoisuuksia halutaan katsoa 
• annetaan vasempaan lohkoon tarkasteltavien laskentasolujen paikat 

▪ Jos tällä välineellä haluaa katsoa havaintoputkien kohdalta, on syötettävä niiden 
tiedot tähän 

• Read: avataan jokin ucn-tiedosto 
o MODFLOW head or drawdown file 

• Number of Cells: monenko laskentasolun pitoisuuksia halutaan katsoa 
• annetaan vasempaan lohkoon tarkasteltavien laskentasolujen paikat 

▪ Jos tällä välineellä haluaa katsoa havaintoputkien kohdalta, on syötettävä niiden 
tiedot tähän 

• Read: avataan jokin fhd-tiedosto 
o MODFLOW Hydmod package 

• Saadaan pohjaveden pinnan/painekorkeuden aikasarjat havaintopisteiden kohdalta 
• MODFLOW:n puolella on pitänyt aktivoida  
• Read -> avataan jokin hyd_out-tiedosto 

 

  

https://water.usgs.gov/nrp/gwsoftware/GW_Chart/GW_Chart.html
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for Simulation of Advection, Dispersion, and Chemical Reactions of Contaminants in Groundwater 
Systems; Documentation and User’s Guide. Contract Report SERDP-99-1, U.S. Army Engineer 
Research and Development Center. 220 p. https://apps.dtic.mil/dtic/tr/fulltext/u2/a373474.pdf 

Videoita 

ModelMuse-ohjevideot https://water.usgs.gov/nrp/gwsoftware/ModelMuse/ModelMuseVideos.html 

Internet-sivuja 

USGS:n info-sivu MODFLOW-aloittelijoille: https://water.usgs.gov/ogw/modflow/new-start-here.html 

  

https://julkaisut.liikennevirasto.fi/pdf1/4000102-tiesuol_vaik_tarkeilla_pohjavesialueilla.pdf
https://pubs.usgs.gov/twri/twri6a1/html/pdf.html
https://www.doria.fi/handle/10024/138614
http://pubs.er.usgs.gov/usgspubs/ofr/ofr94464
https://helda.helsinki.fi/handle/10138/41774
https://pubs.usgs.gov/tm/tm6A29
https://apps.dtic.mil/dtic/tr/fulltext/u2/a373474.pdf
https://water.usgs.gov/nrp/gwsoftware/ModelMuse/ModelMuseVideos.html
https://water.usgs.gov/ogw/modflow/new-start-here.html


Liite 1 

 

 

13 

 

Liite 1: Päävalikon osat 

 

File 

 

New: Luo uusi 

➢  

Open: Avaa aiemmin luotu malli 

Save / Save As: Tallenna / Tallenna nimellä 

Import: Tuo 

➢  
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File (jatkuu) 

 

Export: Vie 

➢  

Files to Archive: Lista tiedostoista, jotka sisällytetään mallin arkistoon 

Exit: Lopetus 

Edit 

 

Undo: Kumoa 

Redo: Tee uudelleen 

Cut: Leikkaa 

Copy: Kopioi 

Paste: Liitä 

Select All: Valitse kaikki 

➢  

Invert Selection: Vaihdetaan valinta päinvastaiseksi 

Edit Image: ModelMuseen tuotujen kuvien muokkaus 

Show or Hide Images: Näytä / Piilota (tausta)kuvat 

Delete Image: Poistaa ModelMuseen tuotuja (tausta)kuvia 

Clear Undo/Redo Stack: Tyhjentää Kumoa / Tee uudelleen -muistin 
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Grid 

 

Generate Grid: Luo laskentaruudukko 

Delete Grid Line: Poista viiva laskentaruudukosta 

Move Grid Line: Siirrä viivaa laskentaruudukossa 

Add Vertical Grid Line: Lisää pystyviiva laskentaruudukkoon 

Add Hrizontal Grid Line: Lisää vaakaviiva 
laskentaruudukkoon 

Specify Grid Lines: Määritä laskentaruudukon viivat 

Subdivide Grid Cells: Jaa laskentasolut 

Set Width: Aseta laskentasolun leveys 

Smooth Grid: Tasoita laskentaruudukko 

Drag to Rotate: Kierrä laskentaruudukkoa vetämällä 

Specify Grid Angle: Määritä laskentaruudukon suunta 

Rotate Grid Around Grid Origin: Kierrä laskentaruudukkoa 
alkupisteen ympäri 

Move Grid: Siirrä laskentaruudukko 

Set Selected Col, Row, Layer: Määritä näytettävä sarake, 
rivi, kerros 

Select Column, Row or Layer: Valitse näytettävä sarake, 
rivi, kerros 

Data 

 

Edit Global Variables: Muokataan globaaleja muuttujia 

Edit Data Sets: Muokataan tietojoukkoja 

Data Visualization: Väritetään laskentasolut jonkin 
laskentaparametrin arvojen mukaisesti (esim. Kx), 
reunaehtojen mukaan, havaintotietojen mukaan tms. 

Show Grid or Mesh Values: Näyttää valitun tietojoukon 
arvoja sen mukaan, minkä laskentaruudun kohdalla kursori 
on  

Display Data Set Values: Näyttää valitun tietojoukon kaikki 
arvot tietyssä kerroksessa taulukkomuodossa 

Delete Model Results: Poistaa mallin tuloksista kaikki ne 
tietojoukot, jotka on luokiteltu "Optional|Model results", sekä 
kaikki ne objektit, jotka ovat määrittäneet kyseiset 
tietojoukot.  

  



Liite 1 

 

 

16 

 

Object 

 

Select Objects: Valitse objekti 

Select Vertices: Valitse kulmapiste 

Selecth With Lasso: Valitse lassolla 

Create: Luo 

➢  

Edit: Muokkaa 

➢  

Search for Objects: Etsitään objekteja niiden tietojoukkojen tai 
reunaehtojen perusteella, joihin ko. objektit vaikuttavat 

Show or Hide Objects: Näytä / Piilota objekteja 

Show All Objects: Näytä kaikki objektit 

Hide All Objects: Piilota kaikki objektit 

Select Objects by Name: Valitse objektit nimen perusteella 
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Navigation 

 

Zoom / Zoom In / Zoom Out: Zoomaa valintaan / lähemmäksi / 
kauemmaksi 

Pan: Panoroi 

Restore Default 2D View: Palauta 2D-oletusnäkymä 

Undo Position: Kumoa sijainti 

Redo Position: Tee uudelleen sijainti 

Go To: Siirry johonkin sijaintiin, laskentasoluun tai objektiin 

Measure: Mittaa 

View 

 

Vertical Exaggeration: Pystysuoran akselin suurennus 

Show Formula Errors: Näyttää kaavat, jotka on palautettu 
oletusarvoon, koska ne olivat virheellisiä 

Errors and Warnings: Näyttää virhe- ja varoitusviestit 

List Selected Objecs: Avaa valittujen objektien valintaikkunan 

Show Grid Shell: Näytä / Piilota laskentaruudukon kehikko 3D-
näkymässä 

Show Top Grid: Näytä / Piilota laskentaruudukon kerros 3D-
näkymässä; sama, joka on valittu näkymään näkymässä Päältä 

Show Front Grid: Näytä / Piilota laskentaruudukon rivi 3D-
näkymässä; sama, joka on valittu näkymään näkymässä Edestä 

Show Side Grid: Näytä / Piilota laskentaruudukon sarake 3D-
näkymässä; sama, joka on valittu näkymään näkymässä Sivulta 

Show 3D Colored Grid: Näytä / Piilota väritetyt laskentasolut 3D-
näkymässä 

Show 3D Objects: Näytä / Piilota objekteja 3D-näkymässä 

Show or Hide 2D Grid: Näytä / Piilota laskentaruudukot tai niiden 
osat 2D-näkymissä 

Restore Default 3D View: Palauta 3D-oletusnäkymä 

3D Lighting: Muuta 3D-näkymän valaistusta 

Customize 

 

Font: Fontti 

Color: Väri 

Hint Display Time: Vinkkien näkymisen keston säätäminen 

Ruler Format: Viivaimen säätäminen 

Batch File Additions: Lisäysten tekeminen eräajotiedostoon 

Show tips: Näytä vinkkejä; valittuna ollessa ModelMuse tarkistaa 
päivittäin, onko nettisivulleen tullut uusia vinkkejä ohjelman 
käyttöön ja jos on, näyttää niistä yhden; useimmat niistä sisältävät 
ohjevideoita 

Show or Hide Rulers: Näytä / Piilota viivaimet 
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Model 

 

Edit Geo Reference: Laskentaruudukon sijainnin, 
kiertokulman, ajan ja yksiköiden muokkaaminen 

MODFLOW Packages and Programs: MODFLOW:n 
pakettien tarvitsemien ei-spatiaalisten tietojen syöttö 

MODFLOW Layer Groups: Kerrosrakenteen muokkaus 

MODFLOW Hydrogeologic Units: MODFLOW:n 
hydrogeologisten yksiköiden muokkaus, käytettävissä 
HUF2-paketin yhteydessä 

MODFLOW Time: MODFLOW:n laskentajaksojen 
muokkaus 

MODFLOW Output Control: MODFLOW:n tulostiedostojen 
säätö sisällön ja ajankohtien suhteen 

MODFLOW Options: Mallin kuvaus, MODFLOW:n 
yksiköiden, laskentasolujen ”kastelun” ja muiden optioiden 
säätäminen 

MODFLOW Program Locations: Määritellään, mihin 
kansioihin laskentaohjelmat on asennettu 

Link Streams: Ulosvirtauksen muokkaaminen SFR- tai STR-
segmenteille 

Manage Parameters: MODFLOW:n parametrien muokkaus 

Manage Head Observations: Pohjavedenpinnan havaintojen 
muokkaus 

Manage Flow Observations: CHOB-, DROB-, GBOB- tai 
RVOB-pakettiin liittyvien virtaushavaintojen muokkaus 

MODFLOW Name File: Määritellään ModelMusen 
ulkopuolella laaditut MODFLOW:n syöttötiedostot 

Observation Type: Havaintojen tyyppi: kalibroitaessa 
valitaan Observations ja ennusteajoissa Predictions 

➢  

Child Models: Tiheämmän laskentaverkon omaavan 
osamallin muokkaus; käytettävissä MODFLOW-LGR-
mallien yhteydessä 

SWR Dialog Boxes: SWR-pakettiin liittyvien havaintojen 
muokkaus 

➢  

Contaminant Treatment Systems: Tietojen syöttö MT3D-
USGS laskentaohjelman paketille CTS 
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Model Selection 

 

MODFLOW 6: Valitaan pohjaveden virtauksen laskentaohjelmaksi 
MODFLOW 6 

MODFLOW-2005: Valitaan pohjaveden virtauksen 
laskentaohjelmaksi MODFLOW-2005 

MODFLOW-LGR V1: Valitaan pohjaveden virtauksen 
laskentaohjelmaksi MODFLOW-LGR, versio 1 

MODFLOW-LGR V2: Valitaan pohjaveden virtauksen 
laskentaohjelmaksi MODFLOW-LGR, versio 2 

MODFLOW-NWT: Valitaan pohjaveden virtauksen 
laskentaohjelmaksi MODFLOW-NWT 

MODFLOW-CFP: Valitaan pohjaveden virtauksen laskentaohjelmaksi 
MODFLOW-CFP 

MODFLOW-OWHM: Valitaan pohjaveden virtauksen 
laskentaohjelmaksi MODFLOW-OWHM 

PHAST: Valitaan laskentaohjelmaksi PHAST 

SUTRA 2.2: Valitaan laskentaohjelmaksi SUTRA, versio 2.2 

SUTRA 3.0: Valitaan laskentaohjelmaksi SUTRA, versio 3.0 

WellFootprint: Valitaan laskentaohjelmaksi Groundwater Withdrawal 
Footprint 

Help 

 

Contents: Help:in sisältösivu 

Help On Main Window: Perusnäkymän ohje 

MODFLOW Reference: On-line MODFLOW-opas 

Introductory Video: ModelMuseen tutustuttava video 

All Videos: Nettisivu, jolla on lista ModelMuse-ohjevideoista 

Examples: Ohjeet ModelMusen esimerkkimallien luomiseen 

Use Local Help: Käytetään ModelMuse-asennuksen Help-tiedostoa 

Use Online Help: Käytetään netissä sijaitsevaa Help:iä 

File Types: Lista ModelMusen tiedostotyypeistä 

About: ModelMusen versio- yms. tiedot 
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Liite 2: Painikkeet 

 

 

 

 

 

 

Kuva 1. ModelMuse-käyttöliittymän painikkeet, ylärivi   
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Kuva 2. ModelMuse-käyttöliittymän painikkeet, alarivi 

 

 

 


